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Paul Sullivan, art director of colorful animation The 
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a beginner’s guide to set extensions – not to mention a 
gallery bursting with inspirational images. Enjoy!

Welcome to 2dartist issue 110!

JESS SERJENT-TIPPING
Deputy Editor

KEEP UP TO DATE 
WITH 3DTOTAL!

facebook.com/3dtotal
facebook.com/layerpaint

twitter.com/3dtotal
twitter.com/layer_paint

youtube.com/
3dtotalpublishing

vimeo.com/3dtotal
vimeo.com/layerpaint

pinterest.com/3dtotal

instagram.com/3dtotal

google.com/+3dtotalcg

SANDRA POSADA
Sandra Posada is from Medellin, Colombia and for 
three years she has been a freelance concept artist 
and illustrator specializing in character design. Sandra 
has worked on projects for graphic novels and comics. 

JESSICA ROSSIER
Jessica works for films, videogames, or advertising 
companies by providing visual assets as a concept 
artist and matte painter. In 2013 she launched 
WARDENLIGHT studio with Bastien Grivet.

MAXX MARSHALL
Maxx Marshall is a 2D/3D artist making videogame art 
at Fun Bits Interactive. Maxx also freelances for comics, 
trading cards, marketing adverts, illustration and other 
random stuff.



Magazine.Your

Get the most out of it!
If you’re having problems viewing the double-page spreads that we feature within 
this magazine, then follow this handy little guide on how to set up your PDF reader!

Top tips for viewing
For optimum viewing of the magazine, it is recommended that you have the latest version of 
Adobe Acrobat Reader installed. You can download it for free here:

To view the many double-page spreads featured in 2dartist magazine, you can set the reader 
to display “two-up”, which will show double-page spreads as one large landscape image:

Jump to articles
In the Contents pages, we have direct links to all articles within the magazine. If a certain 
article catches your eye, simply click (or tap on handheld devices) on the page number within 
the Contents, and you will be taken straight to that article.

Download resources
Whenever you see this symbol, be sure to click it to 
download free resources to accompany that article!

1. Open the magazine in Reader;
2. Go to the View menu, then Page Display;
3. Select Two Page Scrolling, making sure

that Show Cover Page in Two Page View
is also selected.

www.layerpaint.com
For lots more tutorials and exclusive articles, visit

2dartist magazine is available as a downloadable PDF magazine. If you have an iPad or iPhone, you can drag your 
magazine into your iTunes library – it will automatically add the PDF to your bookshelf in your iBooks app!

Deputy Editor
Jess Serjent-Tipping
jess@3dtotal.com

Sub Editor
Adam Smith

Graphic Designer
Aryan Pishneshin

Publishing Co-ordinator
Adam Smith

Advertising Manager
George Lucas 
george@3dtotal.com

Studio Manager
Lynette Clee
lynette@3dtotal.com

Managing Director
Tom Greenway

Advertising
Media pack and rates are 
available upon request. 
Contact George Lucas: 
george@3dtotal.com

International
Translation opportunities 
and international licenses are 
available. Contact
Melanie Smith:
melanie@3dtotal.com

Subscriptions
Subscriptions can be 
purchased via 
2dartistmag.com.
12-month subscription – 
£23.99 ($38.99 US approx.)
To enquire about 
subscriptions, contact: 
support@3dtotal.com

Distribution
2dartist is an e-magazine 
distributed as a 
downloadable PDF and on 
digital newsstands.

Disclaimer
All artwork, unless otherwise 
stated, is copyright ©2014 
3dtotal.com Ltd. Artwork that 
is not copyright 3dtotal.com 
Ltd is marked accordingly. 
Every effort has been made 
to locate the copyright 
holders of materials included 
in this issue of 2dartist 
magazine in order to obtain 
permissions to publish them. 

Special thanks to 3DHype, 
Hiperia 3D and Veegraph 
for supporting 2dartist with 
banners. Contact George 
Lucas if you would also 
like to show your support: 
george@3dtotal.com

2DARTIST MAGAZINE   |  ISSUE 110

http://get.adobe.com/uk/reader/
http://www.layerpaint.com


4  |  2DARTISTMAG.COM

2DARTIST MAGAZINE   |  ISSUE 110

Contents Issue 110
006_ Bringing the dead to life

Go behind the scenes of the animation The Book of 
Life with concept artist Paul Sullivan

020_ Mastering colored pencils
Marco Mazzoni shares his stunning female 
portraits and flora and fauna renders

031_ Sketch comic art
Maxx Marshall shares his incredibly drawn 
sketchbook pages

048_ The gallery
Eytan Zana and Cristina Lavina Roldan feature in 
this issue’s gallery selection of our top 10 images

064_  Design vehicle concepts
Matt Tkocz shares his process for designing and 
rendering a futuristic dune buggy

076_  Matte painting simple set extensions
Jessica Rossier guides us through a step-by-step 
tutorial to extend a set

086_  Overcome a blank canvas
From a simple idea to a fully rendered 
composition ‒ Meg Owenson shows you how!

098_  Paint fantasy characters
Improve your color and composition with a look 
behind the process of Emily Chen’s image

110_  Create tattooed warriors
Sandra posada introduces the workflow used to 
paint her Japanese woman

116_  Beginner’s Guide to                           
Photoshop Elements
Eric Spray demonstrates speed-painting an 
exterior environment in Photoshop Elements

SAVE 30%!
Subscribe today
 Go to page 074 for details



5

2DARTIST MAGAZINE   |  ISSUE 110



Bringing
the dead to life
Concept artist Paul Sullivan shares a selection of his 
inspirational environment and character concepts and speaks 
about his experiences as art director for The Book of Life

Paul Sullivan



The Artist

Paul Sullivan
pencilprimate.com

Interviewed by:
Jess Serjent-Tipping

Paul Sullivan started in the 
entertainment industry 
as a concept artist in 2003 
and since then has had a 
wide range of experiences 
working at different 
companies and within 
a variety of design style 
aesthetics. Over the past 
ten years he’s jumped back 
and forth between film and 
videogame design, mostly 
as a visual development 
artist and concept artist. 
Paul is currently working 
on development with 
director Jorge Gutierrez, 
and freelancing for various 
clients in the children’s 
book industry.

http://www.pencilprimate.com
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Paul Sullivan kickstarted his career in the 
entertainment industry as a concept artist in 
2003, gaining experience in a variety of design 
styles, and over the past ten years has worked 
between film and game design. Paul took on the 
role of art director for the animated film The Book 
of Life in 2009, and is the man behind the great 
visualizations that brought the characters to life. 
We take a look at a selection of the inspirational 
illustrations as Paul gives us an insight into the 
experiences behind the The Book of Life...

2dartist: Hi Paul, thank you for chatting with 
2dartist! Can you firstly tell our readers a bit about 
yourself and your journey into the industry?

Paul Sullivan: Hi! Thank you for the opportunity to 
be featured in your publication! My journey into the 
entertainment industry has been paved with bumpy 
roads and highs and lows. I have always had the 
attitude that anything worth doing is usually not easy 
and my career path has been no exception. It all boils 
down to passion and determination. I have always 
been a hard worker and kind of a perfectionist. I put 
this pressure on myself and always have. 

So I believe my career path actually started a long 
time ago, with my mother (who is also an artist) 
always encouraging me to follow my heart and love 
of drawing. She enrolled me in art classes at a very 
young age and always encouraged and supported 
my love for art by providing me with the necessary 
tools and encouragement I needed to continue 
falling in love with drawing and painting.

I have had struggles with a lack of passion or 
confidence over the years and have many others to 
thank for restoring that at different stages in my life. 
Usually they didn’t even know that they helped me, 
they were also just finding their way and following 
what they loved. In high school I met Jordan 
Kotzebue and his amazing family of incredible artists. 
They were an example of people who came into my 
life at just the right time. They reignited my love for 
art and design and inspired me to keep going.

2da: How did you develop the style you are 
recognizable for today?

PS: I think style is just a collection of things you 
like mixed with things you inherently do. There are 
certain artists or types of art that I favor, and I have 
my own way of interpreting and more specifically my 
own way of making marks. If you practice over and 
over, you eventually start to develop certain aesthetic 
tendencies whether you’re conscious of them or 

Xibalba final character design painting, The Book of Life – digital paint, Jorge Gutierrez –
character design, Paul Sullivan

Visual Development of Afro perfect slice
concept – traditional pencil and ink,
Paul Sullivan

http://www.2dartistmag.com
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Character design sheet of a moat monster – traditional hand-drawn and digital paint, Paul Sullivan

Concept art sketches and final digital paint – traditional sketches and digital paint, Paul Sullivan
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not. I think this is how you land on a personal style; 
influence mixed with personal taste and practice.

My influences are all over the place. Growing up, I 
loved comics and the art is usually what sold me 
on which book to buy. So early on I was influenced 
by comic artists. Later in art school I studied more 
about different historical art periods. I loved the 
renaissance artists and the baroque artists. These 
two things led me to the intensive study of anatomy 
and figurative art. I used this study as a foundation 
for learning about other styles and dissecting what 
makes them unique. After embarking on my career I 
was influenced by my industry and co-workers. I had 
more exposure to great designers and craftsmen and 
this also influenced me a great deal.

2da: Which artist’s do you admire and how did they 
influence your work? And what keeps you motivated 
to work?

PS: Like I previously stated, in part, my influences 
helped shape my style. They have a wide range from 

different times in my life. Some of my favorite comic 
artists are Mike Mignola, Travis Charest, Frank Miller, 
Chris Claremont, Art Adams, Frank Cho, Mark Schultz, 
to name a few. I have always been intrigued by the 
works of Leonardo and Michelangelo, Carravaggio, 
Klimt, and Schiele. Also, illustrators such as Norman 
Rockwell, Howard Pyle, Harvey Dunn, NC Wyeth, and 
Dr. Seuss.

Current industry people that I love are Jorge 
Gutierrez, Tim Lamb, Alexandre Puvilland, Paul Felix, 
Paul Lasaine, Nico Marlet, and Nate Fowkes, among 
many others.

My motivation for art has always been there, I love 
it. I live a life dedicated to study and growth, it is 
what motivates me. I am motivated by learning 
and growing. There is always something to work on 
with my own skill set. And there is always someone 
else out there that is better at something than me, 
so I draw inspiration from those people and work 
on myself. But a big theme in my artistic growth 
has always been variety. Whether it’s being inspired 

by a different artist or even switching to a different 
medium or analyzing a new style. It keeps things 
fresh and the journey new.

PRO TIP 
Adapt your process
Two things that are constant in 
filmmaking and creating art for 
entertainment 1) making changes 
and 2) delivering on schedule. Work 
on different processes that will allow 
you to deliver your work on schedule 
that gets to the heart of the matter 
whether you have 5 days or 5 minutes. 
Always focusing on the big picture is 
important, and if your process allows 
for your supervisor to ask for changes 
along the way without messing you up, 
it will be easier on both of you.

Frankenstein made of different animals – digital paint, Paul Sullivan

http://www.2dartistmag.com


Lighting key for The Book of Life. Mary Beth explaining the Book of Life to Sasha in the first sequence – digital paint, Paul Sullivan

Lighting key of the Sanchez family standing together with Manolo after he wins the bullfight for his life – digital paint, Paul Sullivan

One of seven early development paintings that established the look of The Book of Life – digital paint, Paul Sullivan – layout, Simon Varela



Artist Timeline Paul’s career so far

2003: BFA in Illustration – emphasis in animation. 
Studied under Larry Kresek at RMCAD in Denver, CO

2002: Lead designer with Alexandre Philippe for 
Chick Flick: The Miracle Mike Story

2003: First concept artist job with Activision – Iron 
Man and X-Men. Moved to San Francisco CA. 

2006: Concept artist at Crystal Dynamics – Tomb 
Raider Anniversary, Tomb Raider Underworld

2007: Concept artist at Namco Bandai Games – 
Afro Samurai

2008: Visual development artist at DreamWorks 
Animation – Megamind

2009: Art lead at Sony – Sly Cooper: Thieves in Time 

2009-2014: Reel FX art director/ production designer 
on The Book of Life

2013: Co-wrote The Art of The Book of Life 

2014: The Book of Life hits theaters

PRO TIPS 
Always focus on the
big picture
When designing, force yourself to 
block in your shapes and foundation 
elements before jumping into the 
details. This keeps your composition 
and design strong for your image to 
look harmonious, and has the specific 
elements fit together better. It will be 
easier on both of you.

Stay loose!
I always remind myself to stay loose 
while drawing and painting. If your 
drawing or painting is laboriously done, 
it’s laborious to look at. If you put your 
own energy and confidence into your 
work, people will respond with the 
same energy. If you have no energy or 
confidence, it is usually apparent in the 
final product and falls flat.

Early development style frame for The Book of Life. One of seven original pieces that helped sell the look of the film – digital paint, Paul Sullivan
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2da: What is your creative process like? Could you 
choose one of your favorite past images (that you’ve 
created) and explain a little about its creation, and 
why it’s your favorite?

PS: My creative process has been to start focusing 
on shapes and design, then reference images to help 
make those designs more solid and believable. I try 

to always step back during the process and force 
myself to think about the bigger picture, analyzing 
why I am making the decisions I am and what should 
be my priorities. 

I feel this keeps the design and foundation strong 
before getting into the details. Details are fun but if 
the idea isn’t there, details are worthless.

So for example, for the Land of the Remembered 
painting, I started with a series of small thumbnails 
showing the shapes I strongly wanted to be a theme 
in the design of the land. In this case, circles and 
spheres, skulls and hearts. So I designed the base 
of the composition with those shapes in mind, and 
then I referenced a lot of different elements that I 
wanted to include in the piece. 
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I justified my design with a story; in this case drawing 
upon the history of modern day Mexican culture and 
folk art. 

The Mayan culture was conquered by the Spanish 
and they built religious structures in place of Mayan 
places of worship. So I used Mayan temples as the 

Mexican folk art, lots of complimentary colors and 
contrast. Once I had a strong base, I worked on the 
details later.

2da: Do you have any favorite software, tools and 
techniques that you use to create your artwork? Any 
that you would recommend to our readers?

bases mostly, and added Spanish colonial elements 
on top of these structures, inspired by that history. 
I included the heart and skull iconography in the 
windows and doorways, wrought iron and sugar 
skulls or Calaveras. Once I got the design in a place 
I was happy with, I did the same with the painting, 
starting with broad strokes and color ideas based on 

Final establishing environment design for the Land of the Remembered– digital paint, Paul Sullivan

Early development concept painting of the Land of the Remembered – digital paint, Paul Sullivan – layout, Simon Varela

http://www.2dartistmag.com


Close up street concept for the Land of the Remembered – digital paint, Paul Sullivan
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A big part of my job was to create the color script 
and find the broad strokes that would later be the 
foundation for our lighting and color, and telling 
the story with color and mood. Half way through 
production I ended up assuming both leadership 
roles on the art side, production design and art 
direction. I took the look of the film the rest of 
the way throughout our final lighting and color 
correcting, then later, helped to promote and discuss 
our journey at various press events and interviews.

2da: What was a typical day like in the studio? How 
did the process go for generating ideas for The Book 
of Life?

PS: A typical day for me would start at 8:30-9am and 
end anywhere from 8pm-12am. During the first 6-8 
hours it was so packed with meetings, presentations, 
giving feedback, doing draw and paint overs, and 

told me he had a fun project he just started on with 
director Jorge Gutierrez; Simon was doing some 
drawing for a pitch and they needed someone who 
could paint and do first look imagery for the pitch. 

After making the introduction, I started working with 
the director and did a series of paintings (around 
eight or nine) and this is what we used to pitch the 
film to executive producer Guillermo Del Toro. He 
would later become our partner in the production, 
21st Century Fox. 

At the time the team consisted of just the five of us, 
Jorge and Sandra (Jorge’s wife) Brad (producer) and 
Simon and myself. Simon and I were at the helm of 
art department and creating the look of the film. We 
hired our art team together and led them to create 
all of the assets in the film, supervising and creating 
along the way. 

PS: I use both traditional and digital mediums. As 
much as I primarily use Photoshop and ArtRage, I still 
love drawing as much as possible with pencil and 
paper, brush pen and charcoal.

A charcoal technique that I love is to cover the whole 
paper with a light wash of charcoal and pull out 
shapes with an eraser. Then I go back and, using a 
pencil, I draw back into the shapes. This gives me a 
strong foundation of value separation before I begin 
adding detail.

2da: You have spent the past five years working on 
the incredibly detailed animated film, The Book of 
Life. Can tell us a bit about that journey and what you 
experienced along the way?

PS: My journey working on The Book of Life began 
when my friend Simon Varela called me up and 

This image was used as a Color Key and 
environment design for La Muerte’s 
castle in The Book of Life. In the end, we 
also ended up using it for matte painting 
purposes as well, and projected most of 
what you see onto simple models in the 
final shot of the film

It also needed to look 
and feel like La Muerte 
and utilize all the design 
language we had already 
established for her and the 
Land of the Remembered

I intentionally incorporated 
hearts, skulls and flower shapes 
into this design, which was our 
main iconography of the film

http://www.2dartistmag.com
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running from one room to another, I sometimes 
didn’t get the chance to even use the bathroom. 

The last hour of the day I used to catch up on notes 
and feedback and doing my art for the show once 
most people have gone home for the day. I lead 
by example, and wouldn’t expect anyone to do 
something that I can’t show myself. It really helps me 
get a better idea of how to have answers to specific 
questions by at least doing one myself. I would set 
the bar and use that as something to point to and 
have discussions about for the rest of the team. They 
would take it from there and make it better!

2da: How do you spend your free time away from 
the demands and deadlines of the creative industry?

PS: I love film, it’s a great way to relax and escape 
from the stress of life. I watch a lot of movies and 

television series. I also love to support my industry, 
and all of the people who work so hard to entertain 
the world. I also exercise to reduce stress and stay 
healthy mentally and physically; jogging, rock 
climbing and practicing martial arts.

Another thing I love to do is sketch! But for myself 
which means I can draw and paint whatever I want 
and not have to adhere to anything specific like I do 
with work.

2da: If you could give emerging and aspiring artist’s 
one piece of advice on working in the industry, what 
would it be?

PS: 1. Work hard on yourself always. 2. Don’t ever 
feel entitled to anything, if you aren’t getting the type 
of work that you want to do, refer to step 1 and you 
will eventually get there. Be easy to work with; try 

to re-frame your personal attachment to your work 
when you get feedback from anyone to look at it as 
a gift they are giving you to help you make your art 
better. Have a good positive attitude always and 
people will want to work with you. Sometimes that’s 
the thing that puts you over the edge or becomes a 
deal breaker.

2da: Finally, what can we expect to see from you in 
the future?

PS: I am hoping to develop my own content while 
continuing to work on high profile films and possibly 
games. I am currently developing my own IP and 
production designing and character designing in 
animation. I would hope to eventually work on live 
action films in some capacity just because I love the 
medium. But we shall see what the future holds. I can 
only work on myself and keep trying to succeed.

I started this piece by 
traditionally sketching the 
castle design which needed 
to represent the heart of 
the Land of the Remembered 
and be reminiscent of the 
Mexican Tree of Life

I also took influences from 
Gustav Klimpt’s Tree of Life 
and Antoni Gaudi’s La Sagrada 
Familia, which you can see in 
what I like to call the ‘organized 
chaos’ of La Muerte’s world

This started as a small traditional 
sketch of just the castle, which 
I then blew up and fleshed out. 
Then I brought it into Photoshop 
where I digitally painted it along 
with the rest of the environment, 
but made sure the focal point 
stayed on the castle as this was 
going to be the first reveal of La 
Muerte’s palace



THE BOOK
OF LIFE IS

RELEASED ON 
BLU-RAY, DVD AND 
DIGITAL HD 16TH 

FEBRUARY

The Artist

Paul J. Sullivan
pencilprimate.com

Xibalba final character 
design painting, The Book 
of Life – digital paint, Jorge 
Gutierrez – character design, 
Paul Sullivan

THE BOOK OF LIFE © 2014 Twentieth Century Fox Film Corporation and Reel FX Productions II, 
LLC. All rights reserved. Not for sale or duplication.

http://www.pencilprimate.com
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Discover the inspiration and techniques behind artist, Marco Mazzoni’s 
stunning colored pencil rendering of female faces masked by flowers and 
small creatures

The Artist

Marco Mazzoni
marcomazzoni.tumblr.com

Materials Used:
Traditional tools

Marco Mazzoni was born in 
1982 in Tortona, Italy, and is 
currently based in Milan.

Mastering colored 
pencils

T R A D I T I O N A L  S P O T L I G H T

http://marcomazzoni.tumblr.com
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Artist Marco Mazzoni is based in Milan, Italy 
where he works from his studio creating 
amazingly detailed color pencil drawings. 
A major part of his work is defined by his 
beautifully rendered female faces; framed by 
birds, butterflies and flowers. His masterful 
renders are fueled by an interest in Italian 
fairy tales, mythology and the extraordinary 
women of history.

It’s amazing what Marco can achieve simply 
with colored pencils!

2dartist: Hello! Thanks for talking to 2dartist. 
First off, could you introduce yourself with a bit 
about your background and projects?

Marco Mazzoni: I started to draw when I was a 
child with the paper in my father’s office. When I 
was 20, I moved to Milan and after 4 years at the 
Brera Academy, I focused myself to learn to draw 
with pencils. 

After a trip in Sardinia where I met with my aunt, 
I began to understand the importance of human 

history. So I started studying all the stories about 
extraordinary women who through their expertise 
on plants, took care of entire countries. Then the 
world decided that they were witches and this 
has deleted the real matriarchal culture.

2da: What does your process involve when 
working with colored pencils? And what is it 
about the medium that has made you work 
exclusively with it?

MM: I have always worked with colored pencils 
and paper. My problem is that I have never been 
able to use ‘liquid’ colors, like oil or tempera. 
During the years at Brera professors hated me for 
this. This led me to concentrate on the pencils. 

I realized that they were considered poor, but 
when used with the painting techniques they can 
give extraordinary results. 

I started to study the chiaroscuro technique of 
Caravaggio’s paintings and tried to apply it to 
my pencil work. All my work is based on the Veil 
technique – beginning with the black-and-white 
(and brown) and then getting to the color glazes.

2da: Can you tell us a bit about your chosen 
subject matter and where you draw your 
inspiration from?

MM: I’m working on two different cycles: one 
with moleskine paper, where I try to revive some 
moments of real life or characters that happen to 
strike me, through the use of animals as subject; 
the other where I try to depict the so-called 
mystical: the woman and her harmony with 
plants and animals. 

The animals in the images are always those that 
carry pollen (butterflies and hummingbirds), 
because I try to create a circle where the three 
subjects are on the same plane/level, like a still 
life, in an attempt to create a perfect harmonious 
scheme where you take from nature without any 
kind of violence.

“I try to create a circle where 
the three subjects are on the 
same plane/level, like a still 
life”

TITLE: Aquarium II
MEDIUM: Colored pencils and ink 
on moleskine paper
DIMENSIONS: 21 x 26 cm

http://www.2dartistmag.com


TITLE: Here Comes The Pain
MEDIUM: Colored pencils on paper
DIMENSIONS: 30 x 21 cm



TITLE: Dysphonia
MEDIUM: Colored pencils on paper
DIMENSIONS: 30 x 45 cm
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2da: How do you like to spend your time when 
you aren’t creating beautiful art?

MM: When I don’t draw I spend a lot of time with 
my dog, running in Milan, trying to cook drinking 
too much beer or wine, reading a lot of books, 

watching too many TV series (I’m a TV series 
maniac, I need to know what are the newest and I 
must see them) and listening to too much music. 

My work has allowed me to interact with some 
of the heroes from my teenage years, such as 
Jessicka Addams of Jack Off Jill and Scarling. 
Near my studio there is a fantastic music bar 
where I go every Saturday night with my girlfriend 
Marta and my friend Diego.

2da: Finally, what are your big aspirations and 
inspirations? And what can we expect to see from 
you in the future?

MM: My biggest aspiration would be to be able to 
live off my work as much as possible, and get to 
know as many interesting people as possible... if 
one day, for instance, I got to meet Kat Bjelland 
(the singer of Babes in Toyland) in person, I could 
die happy. 

My future plan is to try to create a picture book 
with a fairy tale written by a friend of mine. It will 
be interesting to try to draw something new with 
a story behind it... 

Thank you very much for taking the time to 
speak to 2dartist!

“My future plan is to try to 
create a picture book with a 
fairy tale written by a friend 
of mine. It will be interesting 
to try to draw something new 
with a story behind it...”

TITLE: Atropine
MEDIUM: Colored pencils on paper
DIMENSIONS: 30 x 30 cm

http://www.2dartistmag.com


TITLE: The Junkies
MEDIUM: Colored pencils and
ink on moleskine paper
DIMENSIONS: 30 x 30 cm

TITLE: Danse Macabre
MEDIUM: Colored pencils and
ink on moleskine paper
DIMENSIONS: 14 x 18 cm
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TITLE: Martyr
MEDIUM: Colored pencils on paper
DIMENSIONS: 50 x 40 cm

http://www.2dartistmag.com


TITLE: Malalingua
MEDIUM: Colored pencils on paper
DIMENSIONS: 60 x 40 cm
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Maxx Marshall

In this month’s sketchbook, Maxx 

Marshall shares his inspirations and 

techniques, and we take a look into 

his eclectic medley of pencil, ink and 

marker creations

The Artist

Maxx Marshall
maxxmarshall.tumblr.com

Maxx Marshall is a 2D/3D 
artist making videogame 
art at Fun Bits Interactive. 
Maxx also freelances for 
comics, trading cards, 
marketing adverts, 
illustration and other 
random stuff. 

http://maxxmarshall.tumblr.com
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Take a look inside Maxx 
Marshall’s sketchbook of 
characters and creatures...

I am a 2D/3D artist and animator originally 
from Detroit, but my art has lovingly taken me 
to many of the places I’ve dreamed of going. 
I’ve worked in Japan, England, California 
and am currently in Seattle. I’ve done art and 
concept for games like Little Big Planet 3, God 
of War PSP, Daxter, World of Warcraft, Okami, 
and many others. 

I draw constantly. I draw on the bus, at the 
bus stop, at family functions, bars, pubs, 
coffeehouses, and so on. My sketchbook 
is filled with things that I’ve liked over the 
years. The thoughts and ideas are inspired by 
random people, places and things I’ve seen in 
my travels.

Inspiration and ideas
I am inspired by the people and places I see. Be 
it a concepting job in Akihabara or a calming 
vacation in Edinburgh with my family, I am always 
on the lookout for new and interesting ideas. I’m 
a self-taught artist who grew up on comics, role-
playing games and videogames; these helped me 
focus in on the type of artwork I wanted to make. 
I like to sit back with markers, pen and pencil and 
just sketch out random ideas.

Materials
I usually sketch on thick, almost Bristol paper and 
I prefer very bright paper. I have 15 or so clear 
plastic clipboards that I place my paper in as well 
as a piece of Bristol card to stop markers from 
bleeding through. Other than holding my paper 
straight and tidy, the clipboard seconds as a 
lightbox for when I want to iterate on an idea. 

I have lead holders with 3H and HB leads for 
pencil work. I use a mixture of Prismacolor and 
Copic markers to add color to my ideas. When 
inking, I always use Sakura Micron pens because 
I like how they feel on the page. I like markers 
because they are fast and an amazing production 
artist tool, but I’ve been getting into watercolor 
more and more. 

Sketching techniques
When starting an idea, I usually see an iconic 
shape in my head that is based on the person 
on the bus or character. That shape is quickly 
and lightly drawn with the 4H. If I’ve decided to 
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I like fun kinetic action. This was drawn 
to capture a fast paced moment in 
time. It started a series of schoolgirls vs. 
monsters illustrations. 

I like the thought of the orcs wearing 
mismatched armor pieces, as it adds to 
their chaotic nature.

use markers, I’ll color at this stage with only the 
lightest pencils so that there is no smearing or 
smudging. If I’m not adding color I then erase any 
and all construction lines and start in with the HB 
leads. I’ll use the HB to find lines I want and lines 
I don’t. I will then go in with the pen and ink the 
whole thing.
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I was thinking that a great game 
environment section in a zombie-
apocalypse city would be a squatter’s tent 
area. He and his friends would shamble out 
and try to eat your brains... I have an actual 
irrational fear of zombies... really...

My buddy Tom Burns and I are always 
coming up with fun game and comic 
concepts. This one was a story about a 
baby troll king.

PRO TIP 
Ink with conviction
With a good pen or brush, understand that the ink will get to the 
page. Your focus during the inking stage is making sure your pressure 
and control are “on point”. I was letting my daughter use one of my 
pens a while back and she bent the tip from using so much pressure. 
A good friend of mine later used a pen of mine during a drawing 
session and bent the tip as well. A light touch will still get the ink to 
the page; pressure aids in line weights, but excessive force can make 
your pen bleed or worse.
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While taking the bus to work in Sheffield, 
I would draw the people around me as 
zombies and creatures. One afternoon, 
I was greeted by a bus full of kids who 
pushed through one by one to look and 
comment on these guys.

After some concept on God of War PSP, I 
started learning about Native American 
mythology. This guy’s legs were the basis 
for the four seasons. In my head the player 
finds him dead and the feet protect his 
dead body in a boss battle.

I grew up on the Terry Jones and Brian 
Froud Pressed Fairy Books. I never turn 
down a chance to sketch tiny fairy folk. I 
like the offset of this one’s arms. It gives 
him character and describes his species 
a bit more by stating, “They’re a wonky 
looking lot.”
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Fairy folk are beautiful but insanely creepy 
to me. I love the thought of their societies, 
but I am frightened by what they may look 
like. Living just off the Peak District, I kept 
hoping to see a few.

Anti-Grav pigtails. I like to pencil, go in 
with my markers (Prismacolor in this case) 
then toss in some inks. I usually choose 
3-4 shades of cool gray markers for things 
like this.



This guy was based on a biker in Irvine 
California. He was sitting by us and his 
outfit was so retro, that I just kept adding 
and adding until he was what he is. As a 
game character, I assume he’s a sniper.

As an old-school pen-and-paper RPG 
player, I always imagine wizards with these 
giant tomes that housed their greatest 
spells. I wanted this wizard to use his as a 
shield. He’s battling big scary things with 
his book companion.

When penciling something like this, I will 
toss on my favorite music, and get lost in 
the details. Every line, circle and crease 
sketched translates to something as I set 
out to color these guys.
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PRO TIPS 
Teach and learn
While playing a game of Street 
Fighter, an amazingly talented 
fighter told me that he feels 
part of his job is to bring more 
people into the fighting game 
community. I tend to see the 
artistic community the same 
way. I also feel that teaching 
and learning from each other 
is extremely beneficial to the 
community as a whole. I was 
recently discussing nail polish 
with a make-up artist who gave 
me a few great ideas based on 
how she applies the coats of 
polish and the overall effect.

All art is valid
I’ve worked with many amazing 
artists in the past – people who 
have made me want to pack up 
my pens and shuffle off to flip 
burgers. As time has passed, I 
understand that my personal 
loves and happy-button-pushing 
imagery isn’t for everyone. I 
can talk for days with zombie 
enthusiasts, but when at home 
with my daughters respect the 
artists on their favorite cartoons. 
Our community is a creative 
one; we won’t all like the same 
things. When it comes to art and 
design, “Beauty is in the eye of 
the beholder” still rings true. As 
creators we need to remember 
that intolerance towards certain 
genres of artistic expression 
doesn’t help our community. 
Embrace your fellow artists... or I 
will send the Zerg after you!
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Years ago my sister left her markers in 
my care. Until five-six years ago I did all 
my game concepts in grayscale. Since 
opening her old markers and adding 
color to everything, I feel I have grown 
as an artist and production artist.

At the beginning of my time on the 
Little Big Planet franchise, I used thick 
charcoal pencils for my concept pieces. 
I love the tight, tiny little fiddly detail 
lines, but there’s something to be said 
sometimes for letting the eye do the 
work for an artist.

Markers, markers, markers. Markers 
with pencils, markers with black pens, 
markers with charcoal, markers with 
brown pens. I like to test what things 
will look like. I recently bought pencil 
leads from the Czech Republic because 
I couldn’t find them anywhere else. 
Testing, learning and subsequently 
showing my work equals bliss.







Prismacolor people from buses, coffee houses, 
vacations and more. As I get faster and faster with 
markers and sketching I can capture the things I am 
attracted to in random folks and keep these things near when I 
need to make my next comic or game character.

Inks. I personally ‘pull’ lines. Meaning, when inking, I start my hand/lines farther 
away from me, and pull the pen towards me. I find that ‘pushing’ for me tends to 
create wobbly lines. In the end it’s your choice what feels best for you and gets you 
the results you want.



We’re always on the lookout for talented artists 
and their artwork to adorn the pages of our 

magazine. If you think you have what it takes, 
get in touch!

To submit, simply email Jess at  
jess@3dtotal.com with a selection of your 

images or a link to your portfolio online, plus a 
little information about you.

We look forward to hearing from you!

Would you like to see your sketches 
featured in 2dartist magazine?



Image -  Lorenzo Zitta

Italian digital artist Lorenzo Zitta knows how to create thought provoking still 

images with LightWave 11.6. Whether the still is computer-generated with 

LightWave, an artful arrangement of digital photos, or a combination of the two, 

the composition of the scene – with its attention to detail and unusual merging of 

objects – demands a closer look. 

“Thanks to LightWave, I can quickly test many different approaches for my projects. 

I love bringing models into Layout and switching on Radiosity, then start working 

on shading and lighting, bringing in more elements, and testing and improvising 

to get the look I want.” - Lorenzo Zitta.

By artists for artists. 

Download the free trial at www.lightwave3d.com 
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Each issue the 2dartist team selects 10 of the best digital images from around the world. Enjoy!

Crystal Sarcophagus
G-host Lee
Software used: Photoshop
Web: g-host-lee.artstation.com
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http://g-host-lee.artstation.com


Submit your images! Simply email jess@3dtotal.com
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Child of Emptiness Advanced
Cristina Lavina
Year created: 2013
Web: cargocollective.com/cristinalavina
Done in Opus Artz Ltd. for ©Applibot, Inc./ 
Legend of the Cryptids

http://cargocollective.com/cristinalavina


Te Honunui 
Dane Madgwick

Year created: 2014 
Web: danemadgwick.com
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http://danemadgwick.com
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Little story 
Kolobaev Mark

Year created: 2015
mous.squarespace.com

© Mousart
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http://mous.squarespace.com
http://jakubsan.tumblr.com


The Outpost
Eytan Zana 
Year created: 2015 
Web: zanabrush.com
© Eytan Zana

2DARTISTMAG.COM
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http://www.zanabrush.com
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Deep
Sylvain 'Tohad' Sarrailh
Year created: 2014
Web: tohad.artstation.com
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https://tohad.artstation.com


Tomcat series
Piotr Jablonski
Year created: 2014
Web: behance.net/nicponim

2DARTIST MAGAZINE   |  ISSUE 110

57

http://www.behance.net/nicponim


Welcome to Neo-Amsterdam
Wouter Gort
Web: woutergort.blogspot.com
© Wouter Gort

2DARTIST MAGAZINE   |  The Gallery

http://woutergort.blogspot.com
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Tomcat series
Piotr Jablonski
Year created: 2014
Web: behance.net/nicponim
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http://www.behance.net/nicponim
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Golden golem
Francisco Badilla 
Year created: 2014 
Web: badillafloyd.deviantart.com

2DARTISTMAG.COM

http://badillafloyd.deviantart.com
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Design vehicle concepts
Discover Matt Tkocz’s creative workflow for designing and rendering a cool futuristic dune 
buggy. Matt covers techniques and top tips for creating thumbnails, using photos and 
presenting your concept

The Artist

Matt Tkocz
mattmatters.com

Software Used:
Photoshop

Born and raised in Poland 
and Germany respectively, 
Matt moved to California 
to study Entertainment 
Design at Art Center College 
of Design in 2008. After 
graduating in 2012, he went 
on to work in the film, game 
and theme park industry as 
well as dabble in teaching at 
various institutions.

http://www.mattmatters.com
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Learn how to design and 
render cool vehicles...

The brief for this tutorial was to share my 
process when designing and rendering a 
futuristic dune buggy in Photoshop. Like with 
most of my design work, I like to separate the 
process into two phases which should (for the 
most part) not overlap: 

1. Content 
2. Presentation

When I speak of ‘content’ I usually refer to 
the actual design of the object/subject I am 
developing. By ‘presentation’ I mean painting, 
rendering, 3D modeling… anything to make 
the picture pretty to help sell my content. 

The reason for this separation is that I am 
a sucker for pretty pictures and always get 
carried away with rendering before nailing a 
decent design first. Whenever I’m developing 
a design, I intentionally limit my tools and 
perspective choices to the bare minimum to 
not get distracted by cool reflections, fancy 
angles, bounce lights and so on.

There are many artists and designers out 
there who have the ability to work on both 
simultaneously. They can produce a gorgeous 
painting while – at the same time – generating 
a strong design. However, I’m not one of these 
people, so I prefer to keep the process as neat 
and organized as possible so I don’t stumble 
along the way.

01 Thumbnailing: Almost always, my 
first step is line sketching. It is a very 

old fashioned way of approaching a design but 
to me, drawing is still the most intuitive way of 
communicating thoughts rapidly. When I do these 
kinds of scribbles, I think of them more as notes 
rather than drawings because their purpose is to 
put down thoughts – not to look pretty. 

Another thing that I do in this step – of course – is 
to look for reference images. The images I look for 
can range from functional details like suspensions 
or pistons, to more literal references of real world 
examples of existing dune buggy designs. I always 
try to find the obscurest possible sources for my 
reference images in an attempt to stumble on to 

something more original than I would just using 
Google; because if everyone always referenced 
the same images, the designs would end up 
looking the same.

02 Design: When I feel like I can’t come 
up with any more sketches, I pick my 

favorite few thumbnails and try to squeeze every 
last bit of potential out of them by warping, 
tweaking, stretching, combining them and so 
forth. I try to make sure that I don’t overlook 
something valuable.

When judging a design I usually consider four 
categories (in the order of importance): 

1. Appropriateness
2. Believability 
3. Aesthetics
4. Originality

Appropriateness is about context. Does it 
serve the story? Is it appropriate for the target 
demographic? Does the style match the rest of 
the intellectual property? To me, this is the most 
important need a design has to fulfill.

Believability essentially means functionality. Is 
the design’s realism convincing in the context of 
the story? Does it look familiar enough so that 
the audience will understand and accept it in the 
context of the IP?

Aesthetics deals with how pleasing the design is 
to the eye. Are the proportions, stance, silhouette 
and composition attractive? Does it look badass 
and fun?

Originality is – for my money – the least important 
need a design has to serve. If the design is iconic 
and unique that’s great; as long as it doesn’t 
sacrifice points from the other three criteria.

And of course there are special circumstances 
and exceptions, so feel free to take these notes 
with a grain of salt.

Leave no stone unturned when figuring 
out a design

This is the thumbnail that best serves 
the needs of the design brief

“If everyone always 
referenced the same images, 
the designs would end up 
looking the same”

http://www.2dartistmag.com
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03 Environment: I compose a rough 
placeholder environment from 

photographs a friend of mine sent me from Chile. 
The reason I start introducing an environment 
at this early stage is that seeing the vehicle in 
a context will hopefully inspire me with further 
design decisions. 

I very rarely present designs isolated against a 
neutral background, because seeing something in 
its natural habitat is an easy way to double check 
whether or not it fulfills the design brief at first 
glance, and a good way to sell your client on the 
design as only few can resist the charm of a full 
color illustration.

04 Block in: Here I begin to block in the big 
shapes of the vehicle to get a better feel 

for its proportions. I do this on a layer between 

PRO TIP 
Double check values
Many designers and artists prefer to figure 
out the values of their designs and paintings 
before they jump into color. That approach 
never quite worked for me as I have trouble 
finding colors that match the previously 
chosen value. 

Instead I keep a grayscale adjustment layer 
on the very top of my image so I can quickly 
double check my value structure. Every once 
in a while I just enable this layer to be able 
to judge my values more easily. If I spot issue 
areas, I disable the grayscale layer and deal 
with the problem in color.

http://www.2dartistmag.com


2DARTIST MAGAZINE   |  ISSUE 110

69

the background and sketch layer. Looking at 
it as solid shapes helps me judge the vehicle’s 
proportions and visual weight easier. I don’t worry 
about the three-dimensional volumes of the 
buggy as much as the two-dimensional graphic 
read at this point. I can always figure out the final 
shape later.

The other day I was at the Singapore airport 
and saw those little golf cart-like buggies driving 
around the terminal. When I saw their puffy little 
wheels I thought those could look great on my 
dune buggy. So I took a quick photo and dropped 
them in my piece. I select the wheel in the photo 
using the Polygonal Lasso tool and copy-and-
paste it onto my image (Ctrl+C and Ctrl+V), then 
you can use Edit > Free Transform to scale and 
skew to fit in with the image.

05 Refinement: I merge (Layer > Merge 
Down) all the layers of the vehicle’s body 

so I can work on it more intuitively and quickly. 
And generally speaking I always try to work 
with as few layers as possible to not overwhelm 
myself. In this step I’m fixing symmetry and 
perspective issues, as well as refining the shapes 
some more. 

This is a tricky step in the design process. While 
I’m trying to fix some of the design flaws and 
perspective issues, I must be careful not to 
venture too far from the aspects of the sketch that 
got me attracted to it in the first place. So as I’m 
tweaking the shapes and proportions I always 
keep an eye on my original sketch, constantly re-
evaluating to make sure to maintain the gesture 
and energy from the original thumbnail.

06 Integration: I’m taking a break from 
the vehicle design to spend some time 

on the environment and its integration with the 
vehicle. I push and pull the values of the image 

Giving the design context in the form of 
an environment can inform upcoming 
design decisions

Blocking in the big masses of the sketch 
instantly helps to judge its proportions 
and silhouette

Resisting the overwhelming urge to begin 
rendering adds valuable time to the 
design process and can save the design

Adding some drama to the environment 
can help make the whole illustration 
more dynamic and exciting
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to increase the scale, depth and clarity of the 
vehicle’s silhouette. You can do this by using the 
Adjustment Layers and moving the sliders, or 
altering the curves until you reach the desired 
effect. I’m not very happy with the mood of the 
image, and try to push it to something much 
more dramatic and less inviting by darkening the 
sky and casting a big shadow on the mountains in 
the background. 

I cast a soft shadow on the foreground to separate 
it from the middle ground and further increase 
the sense of depth. The buggy’s cast shadow gets 
some attention to make it wrap more realistically 
around the rocky ground surface.

07 Volumes: Once I’m more or less satisfied 
with the two-dimensional graphic read of 

the image, I begin to define the volumes. For that 
I add a simple clear coat layer to the body of the 
vehicle allowing me to ‘sculpt’ the 3D shapes of 
the design. I also changed the color of the vehicle 
to red to make the cool tones in the reflections 
pop more. 

Another way to indicate 3D form change is by 
adding highlights. I use them sparingly at this 
point as I don’t want to render just yet. I only add 
subtle highlights to indicate form changes that 
can’t be indicated with a sky reflection. 

I’m adding secondary photo details such as 
headlights and a driver, painting on top just 
enough details to integrate them convincingly 
into the illustration.

08 Details and effects: At this point I do 
further subdividing and refining of the 

big shapes, adding color and value variations as 
well as cutlines and more photo details. When 
adding cutlines, I constantly remind myself that 

it’s not lines that I am designing but rather the 
shapes of the surfaces by dividing them with the 
added cutline. 

The majority of the important decisions have 
been made at this point so all that’s left in the 
process is the final details, polishing and making 
the illustration pretty. 

I also apply a dust layer to the vehicle in order to 
ground it in its environment more. Finally I add 
some effects like a dirt pass (added with a scatter 
brush) and some blur to the lens (Filter > Blur > 
Lens Blur).

09 Orthographic views: Whenever 
making orthos, I usually start off with 

the most descriptive view. In the case of most 
land vehicles, that would be the side view. Once 
I lock the main shapes in the first view, I project 
out the hard points to the top and front view. 
From here it’s usually a lot of going back and forth 
between the different views; adjusting, detailing, 
transferring, and re-adjusting. 

“The majority of the 
important decisions have 
been made at this point so all 
that’s left in the process is final 
details, polishing and making 
the illustration pretty”

http://www.2dartistmag.com
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I don’t go out of my way to stay 100% true to the 
design I already figured out beforehand ‒ if I see 
an opportunity for improvement I’ll go for it and 
adjust the illustration later on. I try to stay flexible 
and work organically until the design is complete.

Adding a subtle hint of 
reflectivity with clear coat layers 
is all it takes to start defining the 
three-dimensional volumes of 
the dune buggy

Adding detail and areas of high contrast 
selectively can help lead the viewer’s eye 

Orthographic views ready to hand over to 
a 3D modeler



The Artist

Matt Tkocz
mattmatters.com

http://www.mattmatters.com
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SAVE 30%!
when you subscribe to today!

• Save a huge 30% – the equivalent of
four issues

• Hassle free –  no need to visit
the shop every month

• Simple, easy payment options
with PayPal Subscriptions allowing 
you to pay with your PayPal account 
or credit/debit card

• Never miss an issue and no need
to re-subscribe each year

Subscribe online at
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Offers are available worldwide. You will receive 12 issues in a year. Minimum subscription term is 12 months. If at anytime during the first 60 days you are 
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before signing up as this magazine offers an incredible insight 
to the world of 2D art. Can’t wait for next release.”
3dtotal customer
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Matte painting 
simple set extensions
Learn how to create a set extension matte painting in Photoshop with 
this step-by-step tutorial by Jessica Rossier

The Artist

Jessica Rossier
jess-studio.com

Software Used:
Photoshop

Originally from Switzerland, 
Jessica Rossier is currently 
living in France. She mostly 
works for films, videogames, 
or advertising companies by 
providing high-quality visual 
assets, as a concept artist 
and matte painter. Since 
2008, she has worked with 
Bastien Grivet, and in 2013 
they launched WARDENLIGHT 
studio in Montpellier.

Layered PSD files
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Improve your matte painting 
skills with these pro tips...

In this step-by-step tutorial, I’ll show you 
how to create a simple set extension by using 
only photographs and basic techniques. You 
will learn how to separate the foreground 
of an image from the background’s sky by 
using the channels panel; how to separate 
all your elements and clean them up using 
different forms of selection tools; importing 
and adjusting new elements like the sky and 
mountains; how to add depth to your scene by 
using the same main image; and finally, how 
to blend all your elements in the final result 
with little color corrections. 

In order to do this tutorial correctly, you 
just will need Photoshop (at least from CS6 
version) and if possible a Wacom tablet. I have 
also supplied two PSD files containing the pre-
masked mountains and of course, the PSD of 
the complete scene.

01 Analysis and selection of the main 
photo: First, to create a matte painting 

I take the main photo where I’ll create my 
future universe and I analyze the details and 
peculiarities of this picture (the perspective of 
the buildings, the direction of the light, intensity 
of lighting and so on). Then I choose several 
elements that will fit into my scene.

From this analysis I will also choose what items I’ll 
keep or remove.

02 Remove the items: Now, as I know 
what I want to do, I start by erasing the 

sky from my scene. To do this you have many 
options, but for this blue sky I choose to work 
directly with the channels. 

01a: The original main photo
01b: Analysis of the lighting direction
01c:   Analysis of perspective elements
01d:  Selection of the items to be removed

02a: Selection of the best channel (blue)
02b:  Get the most contrast by using the 

Curves panel

“I duplicate the blue channel 
because it is the one that 
offers the most contrast 
between light and dark”
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First I duplicate my main layer then I select the 
old one and open the Channels panel. I duplicate 
the blue channel because it is the one that offers 
the most contrast between light and dark. Now I 
need to have a maximum contrast between the 
sky and the roofs. So I press Ctrl+M to open the 
Curves panel and I give as much contrast as I can 
by dragging the first point down from the left to 
the right.

03 Light and dark: To finalize a perfect 
contrast between light and dark, I take 

my brush tool (preferably a Hard brush) and I 
paint all the bottom of the picture black. Then 
I erase all the cables from my scene with white 
( just paint over the cables and electricity poles to 
make them disappear). 

Once this is done I make my selection by pressing 
the little circle at the bottom of the panel. I then 
go back to the Layers panel (click the main scene 
layer) and press the Delete key to erase the sky 
and the cables.

04 Isolate the details: Now, I would like to 
get back the cables and electricity poles 

in the scene. So I start by isolating the cables and 
electricity poles. 

First, in the Layer panel I select my second layer 
(Cables). Then I go back into the Channels panel 
and I duplicate the ‘blue’ channel again. By using 
the Lasso tool I select the entire area of cables. I 
create a high contrast between the sky and the 
cables with the Curves panel (the same action as 
before in step 02). Once I have defined the best 
contrast, I deselect. Now I mask the roofs and 
houses with my white brush tool. 

At this point several zones of the sky are too dark. 
Using the Dodge tool with a large Soft brush, I 
softly paint the parts of the sky that are too dark. 
Then I repeat the same action, but this time 
with the Burn tool in order to strengthen the 
cables. I paint using the appropriate pressure to 
strengthen the cables.

Once it’s done, I press the little circle at the 
bottom of the panel and go back to the Layers 
panel. I click on the second layer (Cables) and 
press delete.

05 Change and cleaning the canvas: Now 
I have two layers ‒ one with my houses 

and roofs without the sky, and another one with 
the cables and electricity poles only. At this point I 
need to do a first cleaning pass of the scene. 

I choose to erase the lens flare effect on the left. In 
order to do this I select a similar piece of the roof 

http://www.2dartistmag.com
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03a:  Using the brush tool to paint the 
white and black zones

03b:  Press the little circle to create a 
selection on the white zone

03c: The scene without sky and cables

04a:  Using the Lasso tool to select the 
cables and electricity poles 

04b:  Painting the roofs and houses white 
with the brush tool

04c:  Using the Dodge and Burn tool 
to separate the cables and   
strengthen them 

04d:  Press the little circle to create a 
selection around the cables
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and duplicate it. I put my little piece of roof over the lens flare effect and 
I adjust the size of it in order to fit perfectly with the rest of the roof. Now I 
make that the man on the bike ‘disappear’ with the Clone Stamp tool.

06 Add the new sky: As I have finished cleaning the scene, I 
will now add the new sky. I import the picture named sky.jpg 

(downloaded from www.cgtextures.com) and place it below all the 
layers. I adjust the position in order to have the sun of the new sky in 
the right direction (use the Warp effect on the layer ‒ Edit > Transform > 
Warp to get a better composition of the sky in the scene).

07 Creating the extension and the depth: So, it’s time to come 
to the main point of our work: the extension of this scene. The 

purpose is to add more depth in the street. 

First, I erase the end of the street ( just after the little red road sign on the 
right) to open it up. I use my Polygonal Lasso tool and carefully select 
what I need to erase. (Tip: just before you delete go to the menu Select > 
Modify > Feather and put 0.5 and press OK — it makes a softer cut and it 
gives a better transition). Now, I can delete it.

The next thing I do is to merge the layer with the cables (Cables) on the 
main layer. I duplicate the main layer (with the houses and roofs) and 
resize it so that it’s smaller and fits with the street’s perspective. I then 
place this new layer under the main one (Main scene) to have the first 
extension of my scene. If necessary move it again in order to fit to the 
perspective correctly. 

http://www.2dartistmag.com


2DARTIST MAGAZINE   |  ISSUE 110

81

Clean and remove the unwanted items

Using the Warp effect to adjust the sky

07a:  Use the Polygonal Lasso tool to 
select a part of the street

07b:  Create an extension with the     
main scene

08a:  Import the mountains and      
modify them

08b:  Flip the canvas to bring a               
new viewpoint 

The next step is to duplicate this extension layer 
and repeat the process to bring more depth to 
the street.

08 Add the background: In order to do 
a creative matte painting, I import two 

mountains to use for the background. I place 
them in the background layer (behind my roofs 
and house). I resize them and I use the Warp 

effect to give them a satisfactory form. The layer 
‘mountain background 2’ should be below the 
layer ‘mountain background 1’ in order to have 
a good composition and a good impression of 
depth. To finalize the scene, I flip the canvas 
horizontally to have – from my personal 
viewpoint – a better composition.

09 Clean and polish: As you have a 
composition of different pictures, it’s 

necessary to clean and polish details to have a 
professional rendering. 

“I flip the canvas 
horizontally to have – from 
my personal viewpoint – a 
better composition”
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First clean all the edges. I hold Ctrl and click into 
the thumbnail of the layer (a small square will 
appear) and all the elements of the layer are now 
selected. I contract my selection then I feather 
it. Now I inverse my selection (Shift+Ctrl+I) and 
when it’s done I use my Eraser tool to erase the 
‘dirty’ edge. I do this everywhere it’s needed and 
I repeat this process for the other ‘houses and 
roofs’ layers.

For the cables (in case they are too light or thin), 
I select the layer where they are and press the 
little checkerboard (Lock transparent pixels) in 
the Layers panel. I then paint on the cables with a 
dark Gradient tool at 10%.

To create atmospheric depth between the 
two mountains and the street, I put one layer 
(ATMOSPHERE 3) above ‘mountain background 
2’, one layer (ATMOSPHERE 2) above ‘mountain 
background 1’ and the other layer (ATMOSPHERE 
1) above ‘main scene’. 

I go on the layer ‘ATMOSPHERE 1’ and create a 
selection from the layer below and paint with the 
Gradient tool at 10% using an appropriate color. 
Repeat the process for the layers ‘ATMOSPHERE 2’ 
and ‘ATMOSPHERE 3’. 

After that I distort the sky with the help of the 
Warp effect to fit it correctly with the scene.

10 Final Touch: I darken the ‘MAIN SCENE’ 
layer to fit to the global light (keep in 

mind that the closer your elements are to the 
viewer, the darker the shadows will be). 

To improve the ambience of the scene, you can 
use several layer effects. The first I will use is a 
Color Balance layer effect in order to warm up 
the scene ‒ it gives us a good sunset ambience. 
Then, I use the Curves layer effect, which helps 
to darken the scene because we are reaching 
the end of the day. So here we are with our final 
matte painting with a simple scene extension.

09a:  The process to clean the edges of 
the elements

09b:  Use Lock transparent pixels and the 
Gradient tool

09c: Adjust the sky with the Warp effect

10a:  Use the Curves panel on the main 
scene to fit to the global light       
and contrasts

10b:  Work with the specific layers 
effects: Color Balance and Curves

http://www.2dartistmag.com
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The Artist

Jessica Rossier
jess-studio.com
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Overcome a blank canvas
Meg Owenson demonstrates how to paint a fantasy environment in this step-by-step tutorial 
sharing useful tips and tricks to get you from an idea to a fully rendered composition

The Artist

Meg Owenson
lastsiren.com

Software Used:
Photoshop

Meg Owenson is a freelance 
concept artist and illustrator 
based in the UK. She is 
currently working in the game 
and film industry.

http://www.lastsiren.com
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You don’t need to wait for inspiration to strike, 
you can make it happen! Start filling you head 
with new visuals. For example, look at the 
photographs from National Geographic, read 
books, look at master artworks, ride the bus or 
go for a walk ‒ do anything which allows you 
to see new things. 

If you can go take photos, these will be great 
for both visual references and for textures 
later on. Then pick maybe three or four 
images/inspirations that you like and start 
thinking about how you can work them into 
a painting. My inspirations were a forest in 
China and the Waitomo Glowworm Caves in 
New Zealand.

01 Just paint! You need to get the ideas 
in your head out onto the canvas to see 

what works and what needs developing. Keep it 
simple – I’m only using three references for this 

Create your own fantasy 
environment with the 
following techniques...

This tutorial aims to show you how I go about 
painting a fantasy environment. By showing 
you the steps I take, I hope to help you go from 
a simple idea to a fully rendered composition. 
I want to start by showing you that you don’t 
need to wait for inspiration or fear a blank 
canvas. Instead, this tutorial shows you how 
to collect inspiration, reference images and 
expand your visual library.

I will then move on to how to mask and work 
on sections of your image, and I’ll show you 
how to create areas of interest that will grab 
your viewers’ attention. I’ll demonstrate how 
to create uniformity in the painting, and lastly, 
I’ll finish off by applying some effects and 
adjustment layers.

piece. This is so it doesn’t look too disjointed. I 
want a forest, a blue glowing lake and some kind 
of ruin which a character could explore. I tend 
to work straight in color, but this step works just 
as well in black-and-white. It doesn’t need to be 
neat; this is the time to experiment. Don’t worry 
about textures or fancy brushes just pick one 
brush and start painting. 

02 Values: This is an important part of a 
painting. A painting can have terrible 

colors but so long as the values work the image 
will read. The easiest way to see your values is to 
place a Hue/Saturation layer above you work and 
take the saturation right down to -100. 

As objects recede into the distance they will get 
lighter and lose contrast. Objects closer to the 
foreground have more contrast and are darker in 
value. The sky will normally be the lightest part of 
your image.

http://www.2dartistmag.com
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Laying down the first sketch in color

Getting your values reading well is the 
most important part of the process

PRO TIP 
Use photo textures 
to aid your vision 
not dictate it
It is so important to start with a 
drawing or rough painting of what 
you want to create. Even if you 
aren’t confident in your painting 
skills, do it anyway. Firstly it is good 
practice and secondly it gives you 
something to work towards. It is 
a blueprint for your final image. 
It doesn’t matter if it’s terribly 
painted; it will keep your whole 
piece focused and stop you going 
off on a tangent when you find that 
perfect photo texture of a waterfall 
or whatever else seems good at the 
time. If it’s not in your blueprint it 
shouldn’t go in. Stay focused, when 
you are using photo textures don’t 
let them dictate your scene.

“Remember to keep 
checking your values 
because adding photos to 
the image can alter them”
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03 Masking: Once I’m happy with my 
composition, I place a vibrant colored 

layer beneath it, and start separating my image 
into sections by erasing different parts. You will 
need to duplicate your initial composition several 
times to get enough layers for everything you 
want to mask. 

For example, I want the sky on one layer so I 
duplicate the image and erase out everything 
that isn’t sky. The brightly colored layer beneath 
allows me to see where I’m erasing. I do this with 
the entire image and then name the layers.

04 Basic texturing: This is when it is good 
to take a lot of photos. If you don’t have 

a library of you own then you can get photos from 
free sites such as www.freetextures.3dtotal.com 
and www.cgtextures.com. 

Once I have the images I want to use to add 
texture and enhance my painting, I import them 
into Photoshop and attach them to the correct 
layer by holding Alt and clicking between the 
layers. I then use the Transform tool to position 
them. Using layer styles and lowering the opacity 
helps settle them into the painting. Remember 
to keep checking your values because adding 
photos to the image can alter them.

05 More painting: This is the stage where 
you can start refining the image. If you 

are struggling with color you can get a lot of 
color information from the photo textures. I don’t 
want the photos to stand out to the viewer, so I 
paint over them until I am happy that the piece is 
looking uniform. 

Remember, the textures should be adding to your 
composition not dictating what it contains. Don’t 
get carried away and lose sight of that initial 
composition you painted. 

06 Atmosphere: An overused but good 
trick to gain atmospheric depth and 

drama is to paint in smoke or in my case mist on 
the lake. I have all my sections of the painting 
separated so I can place mist layers behind and in 
front of key objects, such as the huge ruin in the 
center. This is crucial in order to keep the ruin’s 
crisp edge. You can paint the mist with a big Soft 
brush and by altering the opacity levels. A good 
trick is to paint it on a Screen Layer and drop the 
opacity to get that eerie glow.

Use a bright colored layer to see where 
you are masking out your image

Begin to add photo textures at this stage

Blend the photo textures into your 
image by painting over them

Adding in mist or smoke 
creates atmosphere

Draw attention to your focal points by 
adding more detail
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Use reference images to achieve 
realistic flames

Use image adjustments such as 
Curves to add the final touches

07 Refinement: Add a little more texture 
or paint just in the focal points. If you 

refine only certain key areas and keep the rest of 
the image a little looser, your eye is automatically 
drawn to the areas containing more refinement. 
For this piece I need to place more detail around 
the fires and the ruin itself. I also have smaller 
areas of detail around my character and the stone 
pillar to the left of the lake.

08 Flames/lighting: To get the flames to 
really pop I got a reference image up on 

a second monitor and studied the subtle color 
changes from the hottest part at the center to the 
flickering edges, and the soft brown colors in the 
smoke. Then with a Cloud brush and a super Soft 
brush I replicate the flames. I paint the smoke on 
a Screen layer. Then using a soft brown/orange 
brush on a Color Dodge layer paint the warm 
glow along the side of the ruin.

09 Final adjustments: This is when I merge 
my image down and start to play around 

with some final adjustments. Remember to keep 
a saved file that isn’t merged just in case you 
need to go back to a layer. 

PRO TIP 
The Puppet Warp tool
It will give you much more control over your textures. A handy tool when adding textures in 
Photoshop is to use the Puppet Warp. By pinning down your image in certain sections you 
can bend it carefully over tricky forms. This gives you more control than the Free Transform 
or Warp tool. It is especially good when you want to add bark to a tree you painted or adjust 
a limb on a character.

“If you refine only certain 
key areas and keep the rest 
of the image a little looser, 
your eye is automatically 
drawn to the areas”

At this point the image seems a little light, so I 
add a Curves layer over the top and play around 
until I am happy with the way it looks. 

I also add a little more saturation using the Hue/
Saturation sliders.
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Paint fantasy 
characters
Emily Chen reveals a look behind the process of her image 
A Striped Unicorn, sharing her decisions on pose, color and 
compositions along the way

The Artist

Emily Chen
astripedunicorn.com

Software Used:
Photoshop

Emily Chen is a freelance 
illustrator and concept 
artist in the entertainment 
industry. Currently, she 
is studying character 
animation at the Rhode 
Island School of Design.

http://www.astripedunicorn.com
http://cargocollective.com/cristinalavina
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Discover top techniques for 
painting dynamic fantasy 
characters in Photoshop...

In this tutorial, I will go through the process 
of creating my image, A Striped Unicorn 
from start to finish. I will explain how I go 
about making decisions for pose, color, and 
composition. We will also look at finding 
interesting shapes, and designing a cool 
border/frame for a painting.

Before I start an image, I always like to think 
about the mood/emotional impact that the 
piece will have. Often, I do this by creating a 
playlist of songs that have a similar sound. For 
example, if I am doing an upbeat and happy 
painting, I will often listen to country music. 

If I want my painting to have lots of energy, 
I will listen to electronic/techno remixes. 
For this piece in particular, I listened to a 
combination of classical and slow vocal music. 
Being able to express your idea in every way 
possible before you start is really helpful and 
will save you a lot of time down the road. So 
if music helps you visualize, I suggest you try 
it out!

I began this image with the idea of a character 
being lifted out of the image by a paintbrush. 
Although at first the idea was a bit rough, I 
learned a lot in the process of trying to flesh 
out the concept. While painting, I ended up 
changing my mind quite a bit. 

But because this was a personal piece rather 
than a commercial project, I was able to have 
fun exploring more than usual. It is really 
great when an illustration is able to have a life 
of its own, even if it is not exactly what was 
expected in the beginning. Sometimes it is 
best not to fight it – but rather work with it to 
develop something that is much more magical 
and exciting than the initial vision.

01 Thumbnail: Creating small sketches is 
an essential part of good planning. In this 

phase it is important to focus on the main shapes 
and not get caught up in details. Additionally, it is 
best to do them in black-and-white, for the sake 
of simplicity. I usually work in my sketchbook 
to avoid being able to zoom in and waste time 
rendering. The main point of thumbnailing is to 

try to get a strong focal point. This stage is all 
about good design. Also, make sure you explore 
different possibilities – I suggest at least three 
thumbnails, but the more the better. I once had 
a professor that assigned us to do 55 thumbnail 
paintings of eggs in a day. Not surprisingly, the 
ideas I generated later on were much more 
creative and interesting than the first one.

http://www.2dartistmag.com
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These are the basic, abstract thumbnails 
made for this piece. Emily ended up 
going with the fifth option

This is the compositional breakdown 
of the piece with many diagonal lines 
leading to the focal point

This is the most basic gesture of the 
pose. There is not a lot of detail, but 
enough information to tell what is going 
on in the figure

Here is a close up of the face, achieving 
the main structure and perspective 
before adding detail

02 Block in values/composition: Once 
you have a thumbnail picked out, it is 

then time to start figuring out the main values. 
For this painting I opted for a light character/
focal point against a dark background. The 
dark background allowed me to control where I 
wanted the viewer to look by making the points of 
interest lighter in value. 

In addition, the main light source was coming 
from the right, so I wanted to make sure that it 
stayed consistent throughout the image, in order 
to maintain a sense of weight and structure. 
Because I wanted the image to have motion and 
dynamism, the composition was not balanced, 
and most of the interest shifts towards the right. 

Also, I put in a lot of diagonals and avoided static 
horizontals to further push the unbalance. And 
lastly, to strengthen the focal point even more, 
there were many lines that served as arrows to 
guide the eye to the important areas of light.

03 Basic pose/gesture: Now that I had the 
basic values down, I could start to refine 

the pose. A good way to decide on a pose is to 
choose something that is expressive and tells a 
story. Attending live figure-drawing sessions helps 
a lot with this.

For this image I was going for a sense of motion, 
so I made sure the pose avoided things that 
looked static, such as right angles and parallel 
lines. It also helped to find drawing reference 
online for anatomy and proportion issues. 

I used a Soft airbrush for the skin, and a Hard 
Round brush for the edges. I always have my 
brush opacity set to 100%. Occasionally, to add 
form, I would create a new layer, set it to Overlay, 
and paint with a black or white airbrush.

04 Face and expression: In character art 
the face will always be the main focal 

point of the artwork, so I needed to make sure 
that it looked good. The viewer would probably 
be spending most of their time in this area, so it 
should be one of the most detailed areas. 

I made sure I had the main structure and 
proportion correct before I started adding the 
facial markings and to refine things. I wanted the 
expression to be positive and peaceful, so I made 
her smiling with her eyes closed. 

The perspective of the face was a challenge, and it 
took me a couple of tries to get it to look correct, 
but eventually I was able to settle for something 
that fit in with the rest of the piece. The face was 
not completely realistic and was a bit stylized. In 
my opinion, stylization is far more exciting than 
directly copying the model.

05 Costume: Painting cloth can be a 
challenge, but it is a lot easier if you 

understand the anatomy underneath the 
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clothing. At the end of the day, it’s all about 
understanding form and light. It also helps to 
research the different kinds of folds and what kind 
of form (cylindrical, flat, and so on) causes them. 
Once the main structure and values were blocked 
in, it was time for detail and refinement. 

Detailing the costume had a lot to do with fashion 
design and good research. In this particular case, 
I drew from wedding dress designs via Google 
images. However, I did not want the dress to be 
too distracting from the face, so I darkened parts 
to blend in with the background. I planned to 
paint flowing ribbons to add more dynamic lines 
later, in order to help guide the viewer’s eye to the 
focal point.

06 Atmosphere and background: I started 
to add dust and grunge to the bottom 

and left areas of the image using a Cloud brush. 
This created a sense of depth. I also decided to 
add some small brushstrokes to lightly suggest 
snow in the background. 

However, I made the snow directional for 
compositional reasons. This was a much better 
alternative to just having a black background, 
because it added space and made the entire 
thing look more three-dimensional. To add more 
atmosphere, I made the hair, ribbons and part of 
the costume fade into the background dust. Also, 
I blurred part of the extreme foreground for depth. 
As a final touch, I brightened the areas of dust 
that I felt were most important.

07 Color corrections: For final color 
corrections, I like to merge all my layers 

and go to Image > Adjustments > Color Balance. 
From there, I shift the Highlights and Midtones to 
the Cyan/Green/Blue side, and shift the Shadows 
opposite. Another option is to use the Hue/
Saturation window for adjustments, but the 
changes are not as detailed. 

You can also create a color adjustment layer 
and paint over the image like you are applying 
a wash. This allows you to directly change the 
colors without affecting the values. Or, if you 
have a reference image with an interesting color 
combination, you can try applying a color match 
to your image by going to Image > Adjustments > 
Match Color. 

However, there are countless ways out there to 
play with colors in Photoshop, and I suggest you 
experiment and find what works best for you. 
Some artists are even able to paint their original 
image in black-and-white, and then slowly add 
color via these adjustments!

PRO TIP 
Practice traditional art
Traditional art can really help you speed up the process of learning fundamentals. For 
example, with digital painting, there is no need for color mixing. Every color you could ever 
want or need is right there on the color slider. And wrong colors are easily fixable with hue/
saturation adjustments. However, this prevents you from learning the theory behind colors. 
Taking the time to physically mix color gradients is a valuable exercise, and one of the 
many benefits of practicing traditional art. 

Another valuable aspect of traditional art is its lack of an undo button. As digital artists, it 
is so easy to not think before we paint because nothing is really permanent. So, working 
traditionally forces us to think about every brushstroke we make. It allows us to be more 
aware of our decision making. Coincidentally, this also works the other way around – 
traditional artists can use digital as a way to loosen up and not worry as much. In the end, 
it is all about finding the right balance.

http://www.2dartistmag.com
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Sometimes it is good to vary the 
materials in the costume to create 
interest. For example, the shoulders 
have fur while the lower areas of the 
dress are very smooth

This step was right before adding the 
snow. Although mist was put in the 
background, you can already see the 
difference it is making atmospherically

Here is what the color balance window 
looked like while adjusting the colors for 
this image

08 Final details: The detailing part of the 
process is probably the slowest part of 

the image. It is very time consuming, so it helps 
to know what parts need detail and what parts 
do not. For this painting the most detailed areas 
were in the light, and the darker parts were less 
refined. I started by adding the flowers to the hair 
and small jewelry. I also added hair strands to 
make it look more realistic. 

“In my opinion, stylization is 
far more exciting than directly 
copying the model”
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Be careful not to over-detail though; if there is 
too much detail in the wrong area, it could make 
the painting look gaudy or hard to read. In this 
step, I found myself zooming in a lot and creating 
fewer new layers. In addition, I tended to stick to 
smaller brush sizes. 

09 Designing the border: Creating the 
border design for this painting was 

probably the most challenging part of this piece. 

It helped a lot to look online for examples of how 
borders are used in artwork, and I decided to 

go for rounded edges in order to create a more 
digital/modern look. I also added tree branches 
in order to integrate the white border into the 
image more. However, the branches are stylized; 
they are rounded so that the shapes are not too 
disturbing or jarring. 
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Although detailing can be tedious, it 
really makes a huge difference!

The rounded edges made a really big 
difference in integrating the painting 
with its border

Afterwards, I added white petals to create more 
motion to the image and make the border seem 
like a part of the painting itself. I wanted to make 
sure that the border was a part of the painting 
rather than just a picture frame. Also, I knew that I 
was going to add a paintbrush on the right of the 
image, so I added more space using the Crop tool.

10 The paintbrush and horn: The final 
step was to add the paintbrush and horn. 

First, I painted the calligraphy brush, and made 
sure to add a cast shadow so it looked like it was 
in space. It still seemed a bit out of place, so in 
order to make it look more intentional, I added a 
unicorn horn because it creates fun shapes. 

In addition, I added watercolor-like brushstrokes 
to the right side of the image. This was done using 
a set of splatter brushes. The bottom-right side 
of the image still seemed empty, so all I had to 
do was add a mark/signature for compositional 
reasons and I was done!

PRO TIP 
Overcoming an art block
One of the most common questions I get asked is how to overcome an ‘art block.’ 
Personally, whenever I feel that I am creatively drained, I try to do something completely 
new. For example, if you are a character artist, try painting an environment for a change. 
It may also be fun to try out new tools such as 3D. You could even switch mediums for a 
while and learn how to animate! In my opinion, an art block happens when you are not 
having fun. So, the best way to fight it is to create interest and joy in the art-making process. 
There is also much to be said about simply pushing forward with grit and determination. 
Remember - you will get through this!

The process of adding in the paintbrush 
and water color marks
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The Artist

Sandra Posada
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sandraposada944

Software Used:
Photoshop

Sandra Posada is from 
Medellin, Colombia and for 
three years she has been 
a freelance conceptual 
artist and illustrator 
specializing in character 
design. Sandra has worked 
on different projects for 
graphic novels and comics. 
Currently, she is working 
on her portfolio which 
will allow her to learn and 
practice the foundations 
of art and develop high 
quality images.
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Using silhouettes to figure out 
the concept

Sketching out thumbnails to visualize 
the best composition

so hard due to the fact I had a clear idea in mind 
and a defiant attitude.

After I had worked on the general idea, I had to 
think about the composition of all the different 

Discover techniques to paint 
your own female warrior...

My starting point for this tutorial was to create 
a fierce and independent female character, 
with a balance between beauty, intelligence 
and cunning. 

For this, I researched the Japanese culture, 
warriors and the role of women in this topic. 
After some reading on the subject, I found the 
‘onna-bugeisha’, a kind of warrior that belongs 
to the Japanese upper class. Many wives, 
widows, daughters, and rebels answered the 
call of duty to participate in the battle, usually 
with the Samurai men. This is exactly what I 
want to create, but completely avoiding the 
typical armor.

01 Concept sketch: Once I had the brief, 
I decided to start sketching some ideas 

based on my research. My main goal for this piece 
was to highlight the character with the design of 
the costume – a tight fitting and bold costume – 
therefore I worked in previous silhouettes to find 
the character that I want.

When I chose the one I liked, I defined the size 
of my canvas. I recommend working with a 
minimum size of 2,000 pixels to 300dpi, as this 
helps to assure an appropriate amount of detail 
that is shown in the final image.

02 Planning the composition: It was time 
to define the position by making some 

thumbnails to look at my idea, until I found the 
one that I liked the most. In this case, it was not 

PRO TIP 
Research is very important
Your designs will only be as good as what you know, so for that reason it is important that 
before starting an illustration, you must investigate everything you need – this allows you 
to get a more realistic result, and when you start to work, it will be much easier.
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elements of the image, as well as the character, 
background and supports.

03 Preparing the base: Once I had a clear 
sketch, on another layer underneath, 

I began to add some strokes with a brush with 
a little texture to help me later; I added some 
lighting effects, keeping it soft and without many 
details. I chose desaturated colors to obtain 
contrasts later. When I had the basic structure of 
the body and costume, I started to add color; in 
this case my color range was very simple.

04 Building up the detail: In another 
layer on top I added details, such as the 

folds of the outfit, the volume of the shoulders 
and some little points of light that show the tight 
stocking on the legs. 

PRO TIP 
Volume
With the volume we create an 
illusion of depth, therefore the 
shadows, lights and reflections are 
so important to get a 3D figure in a 
flat drawing.

http://www.2dartistmag.com
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Blocking in the base colors and 
lighting scheme

Painting in the finer details of 
the costume

Blending in the skin tone and 
adding accents of red

Making use of Photoshop filters 
and tools to add atmosphere

Using photos in Soft Light 
mode to add the tattoos and 
transform them to fit the body

Making final adjustments to 
make the image pop

When you have the details on a different layer, 
it makes it easier to modify them. It’s important 
to keep in mind the different reactions to light 
when you are simulating different materials; for 
instance the skin, the kind of fabric, the steel, all 
of them react in a specific way.

05 Refine: I like to spend a lot of time on 
the skin hues. For this, I applied blue, 

violet and red hues to create a warmer and 
brighter aspect, giving the skin different volumes 
generated by the main light source, and keeping 
the chromatic consistency of the drawing.

I then added some blood in different parts of the 
body – red suggests anger, action and danger, all 
the qualities that I wanted to show to the viewer; 
in addition it helped to reinforce an atmosphere 
of battle.

06 Adding atmosphere: Throughout these 
steps I constantly jumped all over the 

place in the drawing, and I gradually started to 
refine it. I used a mix between the Blur filters, the 
Smudge tool and the Soft brush to integrate the 
character with the environment and create some 
more depth.

07 Last piece of the painting: I did not 
want my character to be too generic, so 

I decided to add tattoos (Oukoshisei/Irezumi), 
which originally in Japanese culture meant 
something spiritual and denoted social status. I 
used some photos of tattoos that I had already 
carefully chosen, then I changed the blending 
mode to Soft Light and added noise.

For the background, I searched images about cold 
forests. I put one in the background and applied 
a little bit of blur and atmosphere, next erasing 
where necessary.

08 Finishing touches: As the final stages 
of painting are to add all the details 

that complement the work, I readjusted the 
general light and color, and I darkened the image 

edges on the right side, accentuating a slightly 
more dramatic lighting. I used the Lighten tool to 
make certain areas stand out and create volume. 
Finally I added a fog effect to add atmosphere. 
Dust in the air is always a nice addition because it 
creates a fairytale atmosphere.

I made a copy of all visible layers and flattened 
them. I added a sharpening effect to accentuate 
more details, and I used the Lens Correction 
tool to mimic photographic effects like noise, 
distortion and chromatic aberration.
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The Artist

Eric Spray
sprayconcepts.blogspot.
co.uk

Software Used:
Photoshop Elements

Eric Spray studied at 
the Columbus College 
of Art and design before 
accepting a position at 
Raven Software in 2007. 
At Raven, Eric is a concept 
artist and environment 
art director specializing in 
environment, character, 
and prop design.

Speed Painting
Discover the process Eric Spray uses in Photoshop Elements to create 
a speed-painting of an exterior environment

Beginner’s Guide to Digital Painting in Photoshop Elements:

by Eric Spray
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For this tutorial I’ll be using Photoshop 
Elements to create a speed-painting of an 
exterior environment. Compared to traditional 
media, digital painting is very fast and efficient 
– there is virtually no preparation time and no 
waiting for paint to dry, no mixing paint. For 
those who are starting digital painting with a 
background in traditional art, this will become 
more apparent after a few weeks of practice. 
Photoshop Elements provides a ton of tools 
and resources that will speed up the painting 
process as well.

First, for those of you who are just beginning 
your journey into digital art, speed-painting 
isn’t about how fast you can paint. Speed and 
efficiency will come with practice. If you rush 
the painting process, or neglect the basics of 
design (composition, proportion, and so on), 
your painting will suffer in the end. What’s 
most important is to enjoy the time spent 
painting and not think of it as a race.

Before I start any speed-painting I make sure 
I do a little bit of reference gathering. Even 
with a fantasy-based painting I still want to 
pull ideas from real-world references. What 
you think you see in your head can only take 
you so far, and you may come to a point where 
you need some visual aid to help resolve part 
of the painting. This can cause unnecessary 
frustration that can be easily solved by a quick 
online image search.

http://www.2dartistmag.com
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05 Adjustment layers: When it comes to 
adjustment layers I don’t have a specific 

point during the painting process where I use 
them. In this instance, I just want to deepen the 
darks and push the color a bit more.

I use Soft Light layers more than any of the other 
adjustment layers. It has a really subtle effect – 
almost like a soft glaze that won’t radically alter 

03 Massing shapes: Personally, I like to 
think in terms of volumes, not lines, 

when it comes to speed-painting.

Up to this point, I have not introduced any 
textural or abstract brushes. I have a default set 
of brushes (both custom and standard) that I 
like to use that make it feel more like traditional 
painting.

04 Adding light: I am happy with the 
shapes I massed out, so I move on to 

pushing and pulling the lights and darks in the 
image. I also want to introduce a primary light 
source. I’m going for dark and ominous so I 
restrain myself from going too bold with the lights 
at first – I’ll refine the light setup later.

When I started this painting, I knew I wanted the 
image to have a kind of grim blue/purple tonality. 
My personal art tends to be much more stylized 
and color-amped than the paintings I create at 
work. I’m not shy when it comes to color, though; 
usually I find myself having to pull it back.

01 Starting out: Before starting this 
particular painting I decide to give myself 

a general theme. I really enjoy other-worldly 
landscapes with explorers wandering about. You 
have to paint things you’re passionate about 
if you want to be motivated to paint. I love the 
sci-fi horror genre so naturally I’m going to paint 
images of that type. I’ll walk through my process 
in a series of 29 images explaining the steps 
to reach the final scene. I have a few tricks for 
speed-painting in Elements that I will discuss in 
full as well.

First, I create a new file and set the editing mode 
to Expert. This mode gives you features like layers 
and the necessary tools tab that you’ll use to 
actually paint. With the file open, the first thing I 
do is fill the white space. I hate looking at a white 
void – eventually all the space will be filled up, 
so the Paint Bucket tool is immediately used to 
address this.

My thinking is a dark interior setting, so I choose a 
mid-dark, neutral color for the fill. Generally I will 
start with a mid-value tone and introduce lighter 
and darker tones from there. Be cautious of your 
blacks though, as 100-percent black gives you 
nowhere to go.

02 First marks: With the page filled, I feel 
comfortable starting to sketch out the 

composition. Keeping my brushstrokes loose 
and the brush size large, I want to lay down my 
broadest strokes first to quickly block out the 
scene. I lay in basic shapes as a foundation, with 
the intent of bringing in development details 
later, and generally focus on how I want the eye 
to move across the page – that’s the mentality I 
always lead with.

Filling the void with an 
appropriate color

Making the first shapes on the canvas to 
define the composition

Adding a little color and adding volume 
to shapes

Adding light and shadow to the scene

Using adjustment layers to add subtle 
changes to the atmosphere
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your image like Hard Light or Vivid Light will do. 
I recommend that you experiment and use the 
adjustment styles, but try not to abuse them if 
you can help it. You might be overusing them if 
you have more adjustment style layers than you 
do painted layers.

06 Brushes: Next, I move into the complex 
brush sets. These are based on real-

world references I’ve found. I went into the 
painting knowing I wanted to paint a cave, so 
naturally I found some cool cave references. 
I looked for images of caves that were a bit 
more bizarre and unusual – less typical of what 
a standard cave looks like in my mind. One 
particular cave reference I found had an almost 
fungal quality. I liked how the shapes were more 
amorphous than chiseled and sharp, and it 
inspired quite a few ideas for my painting.

07 Creating a brush: I want to create a 
brush from the references I’ve gathered, 

so the first thing I do is create a new file. I tend 
not to create brushes on top of the painting I’m 
working on, simply for cleanliness.

So after setting up a new canvas, I open up my 
chosen reference image and then copy and 
paste the entire image onto a blank canvas in 
Photoshop Elements.

After reviewing the image and defining the shapes 
that stand out to me, I need to invert the areas I 
want to turn into a brush. To do this I go to Filter 
> Adjustments > Invert, as seen in image 07, or I 
use the shortcut Ctrl+I. Inverting the image isn’t a 
necessary step, and is really only appropriate in 
this instance.

08 Preparing the image: Then I apply 
a Levels adjustment. I’ve found the 

best brushes are made in a high-contrast value 
range: as close to black and white without 
being distorted. This also allows for them to be 
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used as special selection layers that will come in 
handy later. I use this technique superfluously, 
but to pull it off you need to have white space 
surrounding your dark shapes.

09 Selecting the texture: Next, I decide 
what part of the image I want to make a 

brush out of. I use the Lasso tool to trace around 
a specific section of the image, then drop down to 
Edit > Define Brush from the top bar.

10 Finishing the brush: After naming 
your brush, it will be readily available at 

the bottom of the Brush set. I will create dozens 
of custom brushes for individual paintings, 
but consistently use the default Basic Brushes 
throughout, as well.

I almost always apply brush settings to new 
brushes I create. Fade, Spacing, and Roundness 
are the ones I usually play with. For bigger, more 
complex brushes I like to set the Spacing to be 
very wide, so when I paint it lays down more like 
a stencil. Also, Fade is a useful brush setting for 
ghosting brushstrokes into the background.

11 Using the custom brush: So going 
back to the speed-painting, I create 

a new layer where I start introducing the new 
brushes. I lay down only a few strokes, which I 
then distort using the Transform tool. I use it to 
stretch the shape into a position to my liking. If 
you made your brush with white space around it, 
as a clean stencil shape, you can make a selection 
that perfectly outlines the contour of the shape 
by holding Ctrl and left-clicking on the boxed 
preview window of the layer in the Layers tab.

From the selection I just made, I am now free to 
paint only within that shape. I use a very large 

brush to mark within the shape to introduce 
a bit more textural character as well. It also 
camouflages the stencil aspect a bit.

12 Adding highlights: The painting is 
very mid-value still, so I use a large, 

soft-edged brush to pull out some lights. I set the 
Brush mode to Color Dodge – a very fast way to 
brighten up a scene. Be conscious of the color 
swatch you’re painting with, though – the closer 
the value is to white the more drastic the Dodge 
effect will be. To control the effect I choose a 
color in a very dark range. From here I continue to 
employ the same techniques over and over again 
to build up the painting.

In Photoshop Elements you can even save 
selections you’ve made to be loaded up later 

Finding cave references to create a 
custom brush

Preparing sections of the image before 
making a custom brush

Giving the image a stark contrast to 
make a crisp brush

Using the Lasso tool to select the 
area needed

Applying Brush settings and naming the 
brush will finish the custom 
brush process

Making marks with the custom brushes 
you have just made
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when you need them. Once you have a selection 
made, go to the Selection tab and choose Save 
Selection. Next time you need it just go to the 
same tab and choose Load Selection.

13 Flipping the image: Another good 
trick you could use to help give you a 

fresh eye on your painting is to flip the canvas 
horizontally. With traditional media, you have to 
go old school and hold up a mirror to view the 
flipped image, but with Photoshop Elements 
it’s super convenient to be able to work on the 
painting from both of the orientations.

14 Adding more highlights: I saved out 
a layer selection earlier, which I decide 

to use to erase out some parts of the reflection 
and add a little more high-frequency detail. I then 
follow this with another layer of Brush dodging to 
‘pop’ even more light.

At this point I also realize that I need to re-
evaluate the composition again.

15 Characters: It’s now time to introduce 
some figures into the scene. Up to this 

point, I have kept the composition a bit on the 
simple side, knowing that characters and other 
subjects might be introduced later. I wanted to 
make sure they reinforced the composition of the 
image and were not just dropped haphazardly 
into the image.

I outline my ideas for the design in red. I set up a 
hierarchy of character placement and size so that 
one could lead as the dominant figure (the focal 

http://www.2dartistmag.com


2DARTIST MAGAZINE   |  ISSUE 110

123

figure). This is a basic principle of design – having 
large, medium, and small shapes creates more 
visual interest. In this case, they are also staged to 
emphasize spacial depth and distance.

16 Blocking in characters: After blocking 
in the figures I quickly realize that dark 

silhouettes against a dark environment have 
made it difficult to pick out the characters from 
the background, so I decide to give them white 
astronaut gear to make them pop out. This way, 
they look more legible from a quick read.

17 Refining the characters: After adding 
the characters in white, I feel confident 

Adding highlights using either a soft-
edged brush or the Lasso tool to 
create selections

Flipping the image to highlight problems

Adding more detail and highlights to 
the image

Adding figures strategically through the 
piece to create depth

Making the characters stand out against 
the dark background

Refining the detail on the figures in 
the scene
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in fleshing the characters out a bit and adding a 
little more detail to them in general.

18 Checking the image: I don’t like to 
finish one area of a painting and never 

touch it again. I enjoy seeing all the parts of the 
image develop together. The idea being that if 
I decide I don’t like a part of the painting, less 
time will have been wasted than if I spent hours 
modeling sections of it.

I am still a bit unsure about the astronaut designs, 
so I make a mental note to revisit them later on 
(possibly redesign them all together). At this stage 
in the process though, the composition appears 
to be working well from both orientations.

19 Adding atmosphere: All the elements 
are in place, so it’s a good time to start 

polishing some areas of the painting.

So after the flip, I start introducing some fog and 
atmospheric effects. I have a few brushes that are 
specifically designed for doing this, so it doesn’t 
take much time at all to drop some eerie mist into 
the scene.

20 The foreground: Moving from the 
background to the foreground, I continue 

polishing areas around the figures. I take a peek 
at some of the references I had gathered to get 
some detailed information for fleshing out the 
foreground. I mentioned earlier that the cave 
reference had some characteristics of fungus. I 
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decide to play that idea up here and aim for a 
wet-and-spongy ground surface.

To help push the realism a bit more I drop in a 
small section of a photo. When I incorporate 
photos, I like to use them as style guides rather 
than to fill the space up entirely. I will paint out 
and over the photo so it blends in with the rest 
of the painting. Painting over photos you drop in 
keeps the image from feeling like a photo-collage 
and more like a digital painting.

21 Adjusting lights: I continue pushing the 
lights and darks and expanding the value 

range up until the very end, although sometimes 
I have to dial back the contrast range with an 
adjustment layer if I push it too far.

I set my Brush tool to Dodge to quickly increase 
the light influence from the background. If the 
layer is merged, I will erase away areas near 
the Dodge so that shadows do not become too 
greatly affected.

22 Tone control: I feel that the chromatic 
intensity of the painting has become 

too intense over the course of this tutorial. The 
purples appear exaggerated and are inching 
towards the ‘candy’ zone.

To remedy this, I copy and paste a merged layer 
of the entire painting and switch it to a Soft Light 
layer. I apply a Levels adjustment (Ctrl+L) to the 

layer to calm the intense contrast it creates. I then 
make a Hue/Saturation adjustment (Ctrl+H), and 
by setting the Hue/Saturation mode to Colorize, 
I am able to choose a new tonality that will 
influence the atmosphere of the painting.

23 Applying Soft Light: This is almost like 
glazing in traditional oil painting. When 

I set the layer style to Soft Light, it influences the 
overall tonality of the painting and makes the 
purple seem less aggressive.

This speed-painting is interesting for me to 
see evolve. My focus for the first half of the 
painting was purely on mood, atmosphere, 

Again, flipping the image to check the 
designs work well

Adding eerie mist into the scene after 
checking its composition

Adjusting the fungus texture detail into 
the foreground

Pushing the lights and darks to create a 
greater contrast in areas of the image

Toning down the hues to a more 
appropriate level
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and composition, and the subject matter did 
not come about until much later. It was almost 
like building a stage for a play with no props 
or characters in the scene. Once the stage was 
constructed it was about placing subjects into 
the scene that would support and strengthen 
the composition. Keeping the composition fairly 
simple in the beginning gave me the ability to add 
complexity as the painting developed. It really 
depends on the painting, but sometimes I will 
paint the figure in during the block-out stage. As 
long as you’re always considering composition, 
the order in which you paint is not something to 
which you critically need to stay rigidly attached.

24 Creating a vehicle: The last element I 
decide to add to the piece is a vehicle. I 

block out the vehicle in a solid flat tone to begin 
with. I will work with a big shape and erase and 
paint around it until I find something I like. I go 
through a few iterations of silhouettes before 
locking it down.

From there, I create a selection of the shape to 
confine my brush to. This allows me to focus 
on massing out the vehicle in values and color, 
without redesigning the overall shape.

Creating silhouettes is a really important element 
of painting and it’s fairly easy to practice.

25 Integrating the vehicle: With an 
established silhouette, and after 

rendering shapes a bit tighter in the design, I hit 
the vehicle with an atmosphere, fog, and steam 
pass. This brings a bit of dynamism into the area, 
which before, was an inactive space, so to speak.

http://www.2dartistmag.com
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26 Re-checking the characters: I decide 
to revisit the spacemen for a final pass 

and give them a quick quality check. I zoom into 
the image a bit to clean up some edges and iron 
out a few extra details.

With the characters a bit more fleshed out, I then 
do a quick pass of fog to soften some of the edge 
detail work I have just put in. At this point I am 
satisfied with the figures and feel comfortable 
leaving them as they are to the end.

27 Checking the whole scene: I can 
now check the whole scene and review 

from afar. Things I ask myself include: Are the 
characters legible? Is there a clear foreground, 
mid-ground, and background? Does the 
composition move my eye around as intended?

28 More detail: I think it’s at a good point 
to round off and call complete; however, 

a few things bother me. The top half of the 
painting is all pretty evenly dark. To a degree, this 
is okay, but it needs some light information to 
help draw the eye back down into the scene.

As a quick solution to this, I decide to introduce 
some hanging cave spores to the upper right-
hand part of this scene. Placing them in position 
above the dominant figure in the scene will 
encourage the eye to one of the key focal points 
of the composition.

29 Finishing touches: I finish off the 
painting with a Levels adjustment layer 

to maximize the range of darks and lights in the 
scene. I still want the painting to be dark and 
moody so I am conscious not to go too extreme 
on the lights. It’s very easy to over-exaggerate 
these things when you’re just moving a slider bar 
back and forth.

With the last adjustment layer set I consider the 
painting finished. Knowing when a painting is 
finished is a difficult idea in general. You kind of 
have to ‘feel it in your bones’ when you’re done. 
With each sequential painting you create, you’ll 
gain a more acute sense of this.

Along with digital painting, continue to work 
traditionally. Fill up those sketchbooks! Really, 
nothing beats paper and pencil when it comes to 
improving your skills.

I hope this tutorial gives some good insight into 
brush creation, layer selections, and painting 
modes that will help with future paintings you 
create. Keep practicing!

Applying the Soft Light layer to make the 
purple seem less aggressive

Adding the silhouette of a vehicle to 
the scene

Using the vehicle to add activity and 
dynamism to the scene

Checking the detail on the characters

Making changes after reviewing the 
painting from a distance

Redirecting the viewer’s eye by adding 
new cave spores to the scene, and 
checking it works with other elements 
in the scene
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